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1. What TIFF converter for Internet FAX can do
The TIFF converter for Internet FAX allows the Internet FAX connected through a LAN to print like a remote
printer from the personal computer, and converts the document into the format that allows the Internet FAX to
receive and print as a mail. The converter also allows the document to be registered (called "TIFF file creation"
function) as a file.
When Internet FAX receives and prints the file as a mail, the system uses the Simple Mail Transfer Protocol
(referred to hereafter as SMTP), which is the same as the mail protocol used on the Internet. The copy data to
be received and printed is handled as an attached document, or "attachment" to the mail.
Internet FAX uses extension software called the Multipurpose Internet Mail Extensions (refered to hereafter as
MIME) when adding data as an attached document.
Therefore, to send a file as an attached document to the Internet FAX after "TIFF file creation," sending mail
requires using the mailer provided with the MIME function.
The data registered under "TIFF file creation" is compressed using the Modified Huffman (referred to hereafter
as "MH") method used for FAX communication. This data, added with the facsimile information and other
information on the copy, is converted into the Tagged Image File Format or "TIFF".
The version of TIFF converter that supports the MAPI mailer linking function allows a series of useful operations.
These include creating a TIFF file for activating a mail client, opening the screen to send mail, and assigning the
created TIFF file as an attached document. This last operation is automated when the software is set to link with
a MAPI-supported mail client.

2. MAPI (Messaging API)



MAPI (Microsoft Messaging Application Programming Interface) is the common interface for sending and
receiving mail with a Windows application. The interface is actually a group of functions attached to Win32 that
are used to create, transmit, receive, and save mail. Using the MAPI common interface allows you to develop
applications to send and receive mail without having to rely on a particular mail reading program. If you wish to
send data created with a Windows application with e-mail, using MAPI also allows you to send the e-mail
attachment document directly from the Windows application without having to activate another mail client.

The mail clients supporting MAPI include not only Microsoft products, such as Microsoft Exchange, Microsoft
Outlook, and Outlook Express, but also Netscape Navigator and EudoraPro.

How to configure each client's mail settings to support MAPI is briefly explained. For details, refer to the user's
manual for each mail client.

Microsoft Exchange and Microsoft Outlook are registered as MAPI clients when installed.

For Outlook Express, select "Option" from the "Tool" menu and check both "Use Outlook Express as a standard
mail client" and "Use Outlook Express as a simplified MAPI client" on the screen of "General" tab.

For Netscape Navigator, select "Set" from the "Edit" menu, select "mail server" from "Set mail and group," and
check "Use Netscape Navigator for application based on MAPI".

For Eudora, select "Option" from the "Tool" menu and select "Always" for "Use of MAPI server" on the "MAPI"
screen. Also, to send mail to Internet FAX from Eudora, select "Option" from the "Tool" menu, and choose
"MIME (Base 64) in "Conversion system for transmit" on the "Attach" screen.

3. TIFF converter operating environment for Internet FAX
This manual describes the TIFF converter for Internet FAX when used with "Microsoft Windows NT 4.0 version."
System requirements:

e Personal computer with CPU: i486SX(25MHz) or higher (Pentium or higher is recommended)

e Microsoft Windows NT 4.0 version

e Memory: 16 MB or more

e Disk capacity: 4 MB or more

o WWW browser for downloading TIFF converter software online.

e E-mail reader with MIME function for sending mail to Internet FAX using the TIFF file creation function.

4. Installation of TIFF converter for Internet FAX

Installing the TIFF converter for Internet FAX requires that the destination PC and the Internet FAX be
LAN-connected.

In the installation, the system FD or CD for Windows NT 4.0 (not required for the personal computer with Windows
NT 4.0 pre-installed) will be required. Check them and keep them at hand.

1. The file tfntxxx.exe is downloaded as a self-extracting archive type file in zip format. Double-click on it, and it
is extracted.



2. Install the TIFF converter. Click on the "Start" button, point to "Settings" and click on "Printers" to display the
"Printers" window.
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3. Double-click on the "Add Printer" icon in the "Printer" window. "Add Printer Wizard" is displayed. Select "My
Computer" as the printer manager host then click "Next>" button.

Add Printer Whzard

T hiz wizard helps you inztall vour printer or make printer
connectionz.  Thiz prinker will be managed by:

All zettingz will be managed and confiqured on this
computer.

= Metwork printer server

Connect tao a printer on another machine. Al zettings for
thiz printer are managed by a print zerver that has been set
up by an adminigtrator.
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4. Select "LPT1:" and click "Next>" button.

Add Printer Wizard

Click the check box nest to the port(s] pau want to use.
Documents will print ta the first available checked part.

Available parts:

Puart | D ezcription | Printer | -

Local Part

[TLPTZ: Local Port

[TLPT3: Local Port

[ COMT: Local Port

[] Comz Local Part —

[T COM3: Local Port

] COM4: Local Port d
Add Part... | LConfigure Port... |

[T Enable printer pooling
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5. Though the tables of "Manufacturers:" and "Printers:" are displayed, click on the "Have disk..." button.

Add Printer Wizard |

ick the manufacturer and model of vour prinker. [F your printer came with an
s Click. th fact d model of ter. If t th
.!T ¥ installation dizk, click Have Digk. 1F your printer iz not lizted, consult your
printer documentation for a compatible printer.

facturers: Printers:

gfa ﬂ AGFA-AcouSet vE2 3 ﬂ
Apple AGFA-ACcUSetSF wB2 3
APS-PS AGFA-ACcuSet 800
AST AGFA-AccuSet BO0SF 523
ATET AGFAACcuSet BO0SF »2013.103
Brother AGFA-ACcUSet 1000
Rl LI AGEFA-A eSS et TONNSF B2 3 LI

Hawe Dizk... |
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6. The "Install From Disk" dialog box is displayed. Either click on the "Browse..." button or directly type in the

folder filename where the extracted software has been saved. The folder filename can be entered in the
"Copy manufacture's files from:" field.



Inztall From Dizk | x| |
|nzert the manufacturer's installation digk into the drive Ok,
@ selected, and then click OE. -

Cancel |

Copy manufacturer's files from:

Iﬁ j Browse... |

LocaeFie G|
Lookin: | ‘3 Parv = = E=

File name: IElemsetup Open I
Filez of type: ISetupInfDrmatiDn [*.irf) j Cancel |

7. After you have specified the folder in the "Copy manufacture's files from:" field, click on the "OK" button.

Install From Disk

=]
|nzert the manufacturer's installabion disk inta the dive 0k |
@ zelected, and then click OFK.

Cancel

Copy manufacturer's files from:

C:APdr |




8. Return to "Add Printer Wizard". Select "Inetfax01400-US" and click on the "Next>" button.

Add Printer Wizard |

ick the manufacturer and model of vour prinker. [F your printer came with an

i Click. th fact d model of ter. If t th

.!I ¥ inztallation digk, click Have Dizk. If your printer iz not listed, consult vour
printer docurmentation for a compatible printer.

Frinters:

Hawe Disk... |
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9. "Type in the name of the this printer." dialog box is displayed, change the printer name if needed, then click
"Next>" button.

Add Printer Wizard

Type in the name of thiz printer. When you have
finizhed, click Mext.

Maote: Exceeding 31 characters in the Server and
Frinter name combination may not be zupported by
zome applications.

Printer name:

< Back I Mest » I Cancel

10. "Indicate whether this printer will be shared with other network users." dialog box is displayed, choose "Not
Shared", then click "Next>" button.



Add Printer Wizard

Indicate whether thiz printer will be shared with other
nebwork, uzers. |f you chooze sharing give thiz printer a
zhare name.

" Shared & Nt shared

Share Hame: |

Select the operating syztems of all computers that will be
printing to thiz printer.

Windows 35 .
Wéindowes NT 4.0 KPS
Wiindows NT 4.0 Alpha

Wiindows NT 4.0 FPC

Wéindows MNT 2.5 or 3.51 =86

Windows MT 3.5 ar 3.51 MIPS ll
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11. "Would you like to print a test page?" dialog box is displayed, select "Yes" or "No", then click "Finish" button.

Add Printer Wizard

After pour printer iz inztalled, pou can print a test page zo
wou can confirm that the printer iz et up properly.

Would you like ko print a test page’y

< Back I Finizh I Cancel

12. When the entire coping of files completed, "Inetfax01400-US" icon appears in the "Printers" window.
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Now, the install is completed.
Restart the computer after installation is completed.

Note: In case some error message as "Installation Error" shows when installation is completed,follow the
instruction below.

e Delete the TIFF converter installed.

e After restarting the computer, Kindly re-install the printer driver.

13. Next, install the mail linking program. The file mpn4exxx.exe is downloaded as a self-extracting archive type
file in Izh format. Double-click on it in the Explorer, and it is automatically extracted and installation starts.
Follow the instructions displayed on the screen. For details, refer to "How to install" in the "User's guide for
ifax printer driver mail linking program".

The next line shows how to unregister the printer.
Open the "Printers" window, and right mouse click on the printer icon to unregister, then click "Delete" button.

5. How to use TIFF converter for Internet FAX
When installation of the TIFF converter for Internet FAX is completed, "Save as TIFF" function is ready to use in
the same way as a normal printer is used.
Generally, select "Print" from the "File" menu to print.
(For details, refer to the manual for each software.)
When "Print" is selected, the dialog box to prompt selection of "Save as TIFF," "E-MAIL," or "Cancel" is
displayed. (Some applications may hide the dialog box.)

U=ar Print

E-MAIL |

CANCEL |

Select "Save as TIFF" when you send the file as a mail to the Internet FAX later.
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When "Save as TIFF" is selected, the "Create file" dialog box will be displayed to prompt selection of the folder
in which the converted TIFF file is to be saved.

e Specify the location with "Drive" and "Folder".

e Enter the file name to be created into "Filename" field. (Do not change the extension "tif".)

e Do not change "Type of File" field.
Select "E-MAIL" to immediately launch the mail client for MAPI and send the file to the Internet FAX as mail.
When "E-MAIL" is selected, the mail linking function starts to work, the TIFF file is automatically saved, the
transmission screen of the mail client is opened, and the TIFF file saved as an attached document is set. Then,
simply enter the mail address of the Internet FAX to be sent to and press the transmit button to send the mail to
the Internet FAX.

Select "Cancel" to cancel print.

Where the file is printed on Letter size paper, a resolution of 400 dpi can be selected, in addition to standard
200 dpi, for print.

Generally speaking, higher resolution will improve print quality but takes more print time.

To select 400 dpi resolution, select "Page setup” form the "File" menu to bring the "Page setup” dialog box on
screen. Some applications do not provide the selection menu for "Page setup".

For the application that allows the "Print" dialog box to be displayed by selection of the "Print" menu, click on the
"Properties” button for the printer to display the "Inetfax01400-US Document Properties” dialog box.

Page Setup H |

—Paper
Size: Letter hd
Source: I.-“-‘-.utl:u Tray Selection j
— Onentation Marginz [inchez]

& Portrait Left: |1.25" Right: |1.25"

" Landscape Top: 1" Bottar: 1"

()% I Cancel | Prirter... |




Click on the "Printer..." button, and the contents of the printer will be displayed. Click on the "Properties" button.

Page Setup EH |
— Printer
I ame; |netfax0l 400-J5

Froperties |

Stakuis: Ready
Type: |netfax01400-U5
Where: 192 168.64.10:.LP

Commenk:

M etwark... | ] I Cancel

When the "Inetfax01400-US Document Properties" dialog box is displayed, click on the "Advanced" tab, select
"Resolution:" to display "Change 'Resolution’ Settings", then select "400" and click on the "OK" button..

E Inetfax01400-U5 Document Properties HE

F'age Setup Advanced I

@ Inetfax01400-U5 Document Settings

EIQQ Paper/Output

..... @ Paper Size: <Letter:

..... Orientation: <Portraits

ﬁ Paper Source: <Auto Tray Selection:
[‘]llT'j Graphic

..... Resolution: <400

..... Scaling: <100 %>

EJ--ﬁ& Document O ptionz

— Change 'Resolution’ Setting

Hj 400

Ok, I Cancel

Then, click on "OK" and "OK" to close each dialog box and return to the application program. Setting 400 dpi is
now completed.
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